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1. Pengenalan 
 

Macromedia Dreamweaver merupakan sebuah HTML editor Profesional 

untuk mendesain secara visual dan mengelola situs web beserta halaman-

web. 

Saat ini terdapat software dari group Macomedia yang banyak digunakan 

untuk mendesain situs web. Macromedia Dreamweaver 3 merupakan versi 

lama yang menjadi web authoring terbaik pada tahun 2000. Di tahun 

2001, Macromedia meluncurkan Macromedia Dreamweaver 4 yang lebih 

baik dan lebih canggih. Setahun kemudian muncul release terbaru dengan 

sebutan Macromedia Dreamweaver 2002 atau dikenal dengan 

Dreamweaver MX. Dan saat ini, sudah beredar update yang terbaru yakni 

Macromedia Dreamweaver MX 2004. 

Pada Dreamweaver MX 2004 terdapat beberapa kemampuan bukan hany 

sebagai software untuk desain web saja tetapi juga untuk menyunting 

kode serta pembuatan aplikasi web dengan menggunakan berbagai 

bahasa pemrograman web base, antara lain PHP, JSP, ASP dan 

ColdFusion. 

Dreamweaver merupakan software populer yang digunakan oleh web 

designer maupun web programmer guna mengembangkan sebuah situs 

web. Ruang kerja, fasilitas dan kemampuan Dreamweaver mampu 

meningkatkan produktivitas dan efektivitas dalam desain dan maintain 

sebuah web. Dreamweaver juga dilengkapi dengan fasilitas untuk 

manajemen situs yang cukup lengkap. 

Fasilitas penyuntingan secara visual dari Dreamweaver MX 2004 membuat 

anda dapat menambah desain dan fungsionalitas halaman web tanpa 

perlu menulis satu baris kodepun. 
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Anda  dapat membuat dan mengedit image dalam Adobe Photoshop. Anda 

juga dapat menambahkan objek Flash secara langsung dalam Macromedia 

MX 2004. 

1.1 Requirement 
Dibawah ini spesifikasi hardware dan software untuk menjalankan 

Dreamweaver. 

System requirements untuk Microsoft Windows:  

• Processor Intel Pentium III 600 MHz atau lebih cepat.  

• Windows 98, Windows 2000, Windows XP, or Windows .NET Server 

2003  

• Setidaknya RAM 128 MB (rekomendasi 256 MB)  

• Setidaknya sisa space 275 MB  

• A16-bit monitor dengan resolusi 1024 x 768 pixel atau yang lebih 

baik. 

 

1.2 Fasilitas 
User Interface pada Dreamweaver MX 2004 lebih baik dari versi 

sebelumnya. Karena didalamnya memuat peningkatan kemampuan 

tooolbar, dimana bisa digunakan untuk memodifikasi toolbar yang sudah 

ada atau menambahkan fungsi baru. 

Selain user interface baru, Dreamweaver MX 2004 memiliki kemampuan 

untuk menyunting kode dengan lebih baik. Dapat melakukan print kode 

pada jendela Code View, selain itu juga memiliki fasilitas Code Hints 

yang membantu dalam urusan tag, serta Tag Inspector yang sangat 

berguna dalam menangani Tag HTML. Dreamweaver MX 2004 memiliki 

panel baru, yaitu panel Snippets yang memberikan fasilitas untuk 

menyunting dan menyimpan blok kode yang sering digunakan. 

Kemampuan baru lainnya adalah fasilitas untuk menangani dokumen-

dokumen baru seperti XHTML, Extension Manager ditingkatkan 

kemampuannya, kemampuan validasi dan debug di browser serta fasilitas 
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untuk menangani aplikasi database yang sebelumnya hanya ada di 

Macromedia MX Ultradev. 

 
1.3 Memulai Dreamweaver MX 2004 
Seperti halnya dengan program-program lainnya, untuk menjalankan 

sebuah program yang diinginkan, terlebih dahulu anda harus 

mengaktifkan komputer. Dari tampilan program Windows, pilih START 

yang berada di pojok kiri bawah, kemudia pilih ALL PROGRAMS untuk 

menampilkan semua program aplikasi yang terpasang pada komputer. 

Pilih folder MACROMEDIA >>  MACROMEDIA DREAMWEAVER MX 2004.  

Pada saat anda memanggil pertama kali, akan ditampilkan kotak dialog 

yang menanyakan pilihan layout ruang kerja yang ingin anda gunakan. 

1. 4 Ruang Kerja  
Saat Anda pertam kali mulai menjalankan Dreamweaver, akan tampil 

sebuah kotak dialog Workspace Setup yang digunakan untuk memilih 

tampilan ruang kerja. 

 
Gambar 1. Tampilan kotak dialog tipe ruang kerja Dreamweaver MX 2004 

 

• Designer workspace : adalah sebuah penggabungan ruang kerja 

menggunakan MDI (Multiple Document Interface), di mana semua 
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jendela dokumen dan panel tergabung di dalam satu jendela 

aplikasi yang besar, dengan sisi panel group di sebelah kanan. 

Tampilan ini paling disukai beberapa pengguna. 

• Coder workspace : adalah ruang kerja yang tergabung dengan 

letak sisi panel group berada di sebelah kiri. Tampilan yang sama 

digunakan oleh Macromedia HomeSite dan Macromedia ColdFusion 

Studio, dan jendela dokumen menampilkan kode secara default. 

Tampilan ini sudah diakui kemudahannya oleh pengguna Homesite 

atau Coldfusion Studio dan pengguna kode lain yang ingin 

mengenal tampilan ruang kerja. 

 

Ketika Anda memulai Dreamweaver tanpa membuka sebuah dokumen, 

makan akan tampil halaman awal Dreamweaver pada lembar kerja. 

Halaman awal akan memudahkan pengguna dalam mengakses tutorial, 

memilih file yang pernah dibuka, membuat halama baru, membuat 

halaman dari contoh dan Dreamweaver Exchange, dimana anda dapat 

menambahkan kemampuan baru dari beberapa tampilan 

Dreamweaver. Gunakan halaman awal seperti halaman web. Untuk 

menghilangkan tampilan awal, lakukan langkah : 

 
Gambar 2. Tampilan jendela awal 
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1. Jalankan Dreamweaver tanpa membuka dokumen. Halaman awal 

akan ditampilkan pada layar monitor anda. 

2. Klik Don’t Show Again 

Ruang kerja pada Dreamweaver MX 2004 memiliki komponen-

komponen yang memberikan fasilitas dan ruang untuk menuangkan 

kreasi anda dalam bekerja, seperti dalam gambar dibawa ini. 

Komponen-komponen yang disediakan oleh ruang kerja Dreamweaver 

MX 2004 antara lain adalah insert bar, Document toolbar, Document 

window, Kelompok panel, tag selector, Property inspector dan Site 

panel.  

 
Gambar 3. Tampilan ruang kerja 

• Document window : berfungsi untuk menampilkan dokumen 

diman anda sekarang bekerja 

• Insert Bar : mengandung tombol-tombol untuk menyisipkan 

berbagai macam objek seperti image, tabel dan layer ke dalam 

dokumen. 

• Document toolbar : berisi tombol-tombol dan menu pop-up 

yang menyediakan tampilan berbeda dari Document window. 
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• Files panel : memperlihatkan group file berdasrkan site yang 

sedang dikerjakan. 

• Tag Selector : berfungsi menampilkan hirarki tag di sekitar 

pilihan yang aktif pada desin view. 

• Property Inspector : digunakan untuk melihat dan mengubah 

berbagai properti objek dan teks 

• Site panel : digunakan untuk mengatur file dan folder yang 

membentuk situs web anda. 

 
1.5 Komponen Ruang Kerja  
Didalam ruang kerja Dreamweaver MX 2004 terdapat beberapa komponen 

utama yang membentuk suatu ruang kerja. Ruang kerja tersebut 

memberikan kesatuan tampilan antara menu utama, panel, property 

inspector serta toolbar. 

Menu Utama 

Sistem menu yang terdapat dalam Dreamweaver sangatlah sederhana dan 

mudah untuk dipahami karena perintah yang terdapat pada hampir 

sebagian besar fungsi menu terdapat juga dalam panel. Anda tidak akan 

menghabiskan waktu dengan perintah yang terdapat pada menu tetapi 

akan lebih banyak bekerja dengan panel. 

Di dalam sistem menu Dreamweaver terdapat beberapa komponen yang 

dapat digunakan, yakni : 

• Menu file dan Menu edit 

Berisi item menu standar untuk menu file dan menu Edit seperti 

New, Open, Save, Save all, Cut, Copy, Paste, Undo dan Redo. 

Menu file terdiri dari beberapa macam perintah untuk 

menampilkan atau membuat dokumen baru, seperti Preview in 

browser dan Print code. Menu edit berisi perintah untuk 

pemilihan, seperti Select parent tag dan Find dan Replace. 

• Menu View 
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Berisi perintah untuk menampilkan beberapa macam tampilan dari 

dokumen anda (seperti tampilam design view dan tampilan code) 

dan untuk menampilkan dan menyembunyikan beberapa elemen 

halaman dan tombol Dreamweaver dan toolbar. 

• Menu Insert 

Berisikan alternatif baris Insert untuk menyisipkan obyek dalam 

dokumen. 

• Menu Modify 

Berfungsi untuk melakukan perubahan properti item atau halaman 

terpilih. Dengan menggunakan menu ini anda dapat mengedit 

atribut tag, mengganti tabel dan elemen tabel dan bermacam 

bentuk aksi untuk item librari dan template. 

• Menu Text 

Berfungsi untuk mempermudah dalam melakukan format teks 

• Menu Command 

Berisi akses ke beberapa perintah, format kode yang sesuai dengan 

format pilihan anda. Membuat photo album, dan melakukan 

pengeditan gambar. 

• Menu Site 

Berisi item menu untuk mengelola situs dan melakukan upload dan 

download file 

• Menu window 

Menyediakan akses ke seluruh panel, inspector dan jendela dalam 

Dream weaver 

• Menu Help 

Akses menuju bantuan berupa dokumentasi yang telah disediakan.  

 

Baris Standar 

Pada saat anda membuka jendela Dreamweaver MX, secara default hanya 

menampilkan Document Bar tanpa menampilkan Standard Bar. 
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Gambar 4. Standard Bar 

 

Untuk menambahkan atau mengaktifkan Standard Bar, langkah-

langkahnya sebagai berikut : 

1. Buatlah dokumen baru 

2. Pilih perintah menu View > Toolbars sehingga tampil submenu 

Document dan Standard. 

3. Klik pilihan Standard untuk menampilkan standard bar 

4. Gunakan perintah yang sama untuk menyembunyikan tampilan 

Standar bar. Untuk menyembunyikan, anda bisa mengklik pilihan yang 

sudah terpilih. 

 

Icon Nama Keterangan 

 
New Membuat Halaman Baru 

 
Open Membuka Halaman yang sudah ada 

 
Save Menyimpan Halaman web yang sedang aktif 

 
Save All Menyimpan seluruh Halaman web yang sedang dibuka 

 
Cut Menghapus objek yang dipilih 

 
Copy Menyalin objek yang dipilih 

 
Paste Menempalkan/meletakkan objek hasil salinan 

 
Undo Membatalkan perintah yang terakhir dilakukan 

 
Redo Mengulang kembali 
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Baris Tombol Dokumen 

Document Toolbar berisi tombol-tombol dan menu pop-up yang 

menyediakan tampilan berbeda dari document window. Anda dapat 

memberikan judul document window pada bagian Title. 

 
 Gambar 5. Document Toolbar 

Icon Nama Keterangan 

 
Show Code 
Ciew 

Menampilkan mode pengetikan 
kode HTML dalam jendel Code 
View 

 
Show Code and 
Design view 

Menampilkan jendela Code View 
dan jendela Design View 

 
Show Design 
Ciew 

Menampilkan jendela Design 
View sesuai yang akan tampil di 
browser 

 
No Browser 
Check Errors 

Melakukan pengecekan kesalahan 
pada dokumen web 

 
Document 
Title 

Memberikan judul pada halaman 
web 

 
File 
Management Proses Upload dan download file 

 
Preview/Debug 
in browser 

Melihat hasil dalam browser dan 
mencari kesalahan script 

 
Refresh Site 
List 

Melakukan pembaruan terhadap 
daftar isi situs 

 View Options Mengatur pilihan pada ruang 
kerja 

 

Baris Insert 

Terdiri dari tombol-tombol untuk membuat dan menyisipkan obyek 

seperti tabel, layer dan gambar. Ketika anda menggulung pointer 

melewati sebuah tombol, tampil sebuah kotak keterangan dengan 

menampilkan nama tombol. 
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Gambar 6. Tampilan Insert Bar sebelum diganti  

(Untuk mengganti tampilan Insert Bar, Anda dapat memilih Show as Tabs 

pada menu tarik. Selanjutnya tampilan Insert Bar akan berubah menjadi 

Tabulasi diatas Insert Bar) 

 

 
Gambar 7. Tampilan Insert Bar setelah diganti 

 

Baris Insert digunakan untuk mengatur beberapa kategori pilihan sebagai 

berikut : 

• Common memungkinkan untuk membuat dan menyisipkan beberapa 

penggunaan obyek biasa, seperti gamabr dan tabel diatas. 

• Layout memungkinkan untuk menyisipkan tabel, div tag, layer, dan 

frame. Kita dapat memilih 3 tampilan tabel : Standard (default), 

Expanded Tables dan Layout. Ketika mode tampilan dipilih. Kita dapat 

menggunakan tombol layout dreamweaver : Draw Layout Cell dan 

Draw Layout Table. 

• Forms berisi tombol-tombol untuk membuat form dan menyisipkan 

elemen form 

• Text memungkinkan kita untuk menyisipkan beberapa teks dan daftar 

format tag, seperti b, em, p, h1 dan ul. 
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• HTML menyediakan fasilitas untuk menyisipkan tag HTML untuk mistar 

horizontal, head content, tabel, frame dan script. 

• Server-code disediakan untuk halaman-halaman yang menggunakan 

bahasa khusus seperti : ASP, ASP.NET, CFML Basic, CFML Flow, CFML 

Advanced, JSP dan PHP. Selain itu juga disediakan obyek-obyek 

server-code yang dapat disisipkan dalam tampilan code. 

• Application memungkinkan kita untuk menyisipkan elemen dinamis 

seperti recordset, repeated region dan record insertion dan update 

form. 

• Flash Elements untuk menyisipkan objek flash 

• Favorites untuk mengelompokkan dan mengatur tombol-tombol baris 

insert yang anda gunakan dalam satu wadah. 

 

Jendela Dokumen 

Document Window merupakan bagian yang digunakan untuk mendesain 

halama web. Dalam Document Window dipakai untuk menyisipkan teks, 

image serta objek lain yang mendukung pembuatan situs web. 

Tidak seperti versi sebelumnya, Dreamweaver MX memuat dokumen-

dokumen yang sedang dibuka dalam jendela yang sama. Jika anda 

perhatikan untuk dokumen yang terbuka dalam jendela yang sama, akan 

disimpan dalam tab-tab seperti lembar kerja pada Microsoft Excel. 

Dengan demikian anda dapat dengan mudah berpindah antar dokumen 

tanpa harus menutup tampilan jendela yang sudah terbuka, yaitu dengan 

mengklik tab dokumen yang anda inginkan. 
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Gambar 8. Document Window 

 

Panel Group 

Merupakan kumpulan panel yang saling berkaitan satu sama lain yang 

dikelompokkan bersama dibawah satu judul. Kalau diperhatikan pada 

bagian panel group, disitu terdapat beberapa panel yang tersusun secara 

rapi pada bagian sebelah kanan window. Kelompok panel tersebut antara 

lain : Design, Code, Application, Files dan Answer. 

Pada setiap bagian dari panel group terdapat beberapa macam panel 

lagi, misalnya pada panel group Design berisikan panel HTML, Style, CSS 

Style dan Behaviour. Pada bagian panel group Files terdapat panel Site 

dan Assets. Untuk menguraikan panel group, anda bisa klik panah 

expander di sebelah kiri nama group. 

Kita juga dapat memisahkan panel group yang tersusun tersebut dengan 

menggeser mouse pada bagian pojok kiri dari judul group sampai panel 

tersebut terlepas dari panel group. 



  

 14 

 
Gambar 9. Panel Group (Geser pada pojok kiri atas judul panel sehingga 

panel akan terlepas dari group) 

 

File Panel 

Merupakan bagian dari panel group selain panel Assets. Bagian ini 

berfungsi untuk mengatur file dan folder yang akan membentuk situs 

Anda. Panel ini memiliki fungsi lain yang cukup penting karena 

memungkinkan untuk mengatur dan bekerja terhadap file-file tersebut 

dengan efisien. 
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Gambar 10. Files panel didalam panel group files 

Pada bagian ini, kita dapat melakukan beberapa aktivis, antara lain 

manajemen file, koneksi ke remote server, menempatkan file ke server 

atau menyalin file dari server ke situs lokal. 

 

Snippet Panel 

Panel ini merupakan kode yang sering digunakan dan disisipkan pada 

dokumen. Kita bisa mengambil kode snappet built-in yang ada di dalam 

bagian snippet dengan menentukan terlebih dahulu kode apa yang akan 

disisipkan ke dalam dokumen. 

Misalnya: apabila kita ingin membuat sebuah judul beserta menu, maka 

anda harus memilih Headers, selanjutnya anda bisa menentukan bentuk 

dari Headers tersebut. Selain Headers, anda juga bisa menggunakan kode 

lainnya, seperti footer, layout navigasi, fungsi javascript dan masih 

banyak lagi seperti yang dapat Anda lihat pada hirarki. 
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Gambar 11. Snippets panel 

Anda juga bisa menambah atau mengubah kode snippet yang sudah ada 

sesuai dengan kebutuhan. 

 

Tag Inspector 

Salah satu fasilitas terbaru dari Dreamweaver MX. Dalam hal tag 

Inspector anda dapat melihat struktur hirarki tag dan atribut-atribut yang 

dapat ditambahkan atau di edit. 
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Gambar 12. Tag Body dalam panel group tag Inspector 

 

Tag Selector 

Terdapat pada bagian bawah document window atau pada bagian status 

bar. Fungsi dari Tag selector adalah untuk menampilkan hirarki tag pada 

design view yang aktif. 

Pada saat anda mengaktifkan jendela document window, secara otomatis 

pada bagian status bar akan muncul indikator <body> 

 
Gambar 13. Tag Selector 
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Property Inspector 

Digunakan untuk melihat dan mengubah berbagai properti objek dan teks 

yang terpilih. Setiap objek maupun teks mempunyai properti yang 

berbeda-beda. Contoh Properti Teks : jenis font, ukuran, perataan dsb. 

Untuk Image : nama image, ukuran image dsb. 

 
Gambar 14. Property Inspector Text 

 

 
Gambar 15. Property Inspector Image 
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2. Dasar-Dasar Dreamweaver 
 

Sebelum kita memulai membangun situs web. Kita harus mengetahui 

pengertian situs web. Situs web adalah suatu kesatuan dari halaman-

halaman yang terhubung dengan atribut sama. Sebuah web memiliki 

banyak komponen web seperti image, text, media dan objek yang saling 

berhubungan. 

 

2.1 Web Server 
Sebelum kita melangkah untuk mendesain Web, kita diwajibkan untuk 

menyediakan Personal Web Server, hal ini dibutuhkan untuk mengetes 

hasil disain yang sudah dihasilkan lewat browser lokal atau lewat 

jaringan. Ada beberapa produk software Web Personal Server yang bisa 

kita gunakan yakni : Aphace Web Server, Personal Web Server (PWS) atau 

Internet Information Services (IIS).  

Install PWS 

Berikut langkah-langkah untuk menginstal PWS dalam Sistem Operasi  

Window 95/98/Me atau NT Workstation : 

1. Double-click File source progran PWS yang ada dalam Windows 98 CD 

atau download lewat internet. 

2. Ikuti installasi wizardnya. 

3. Ketika menanyakan untuk directori Home Default-nya, ikuti saja 

sesuai default-nya seperti berikut C:\Inetpub\wwwroot  

4. Klik Finish untuk menyelesaikan Installasinya. 

 

Install IIS 

Berikut langkah-langkah untuk menginstal IIS dalam Sistem Operasi  

Window 2000/XP : 
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1. Pada Window 2000, Pilih Start > Settings > Control Panel > 

Add/Remove Programs 

2. Pada Window XP, Pilih Start > Control Panel > Add/Remove Programs. 

3. Pilih Add/Remove Windows Components. 

4. Pilih IIS dan Ikuti Instruksi Installasinya dan persiapkan master CD 

sistem operasinya. 

 

Testing Web Server 

Setelah semuanya beres untuk memastikan apakah web server kita 

berjalan dengan baik maka cobalah dengan cara berikut ini; 

1. Buka Notepad. 

2. Ketikan seperti ini “ <p> Server berjalan dengan Baik</p>”. 

3. setelah itu Save ke file C:/inetpub/wwwroot/test.html (ingat!jangan 

lupa untuk memberikan Extensi .html atau .htm. 

4. kemudian klik internet explorer, kemudian ketikan 

. 

5. Kalau benar akan muncul Tulisan “Server berjalan dengan Baik” 

6. Berarti anda telah sukses memasang web server pada komputer anda 

 

2.2 Membuat Situs Lokal 
Situs lokal memiliki pengertian bahwa seluruh file yang digunakan untuk 

membangun sebuah web tersebut secara fisik berada dalam dalam 

komputer/server yang berdiri sendiri. Kita bisa menempatkan dalam 

folder yang sudah ditentukan. 
 Dalam Dreamweaver, untuk membuat sebuah situs web kita perlu 

mendefinisikan situs dengan menggunakan Kotak Dialog Site Definition. 

Dalam proses pendefinisia, ada 2 cara yang dapat kita pilih. Yakni : Basic 

dan Advance. 
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Adapun langkah untuk mengatur pendefinisian site dengan versi Basic 

sebagai berikut : 

1. Pilih perintah menu Site > Manage Sites 

 
Gambar 2.1 Tampilan kotak dialog Manage Sites 

 

Dalam menu diatas terdapat beberapa tombol New, Edit, Duplicate, 

Remove, Export dan Import. 

Ketika kita memilih New maka akan muncul menu melayang yakni : 

• Site, jika file-file web pekerjaan kita akan ditaruh di folder lokak 

• FTP & Server, ini dipilih bila file-file situs web kita ada di jaringan 

atau komputer lain. 

Kemudian pilih langkah termudah dengan menu Basic 
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Gambar 2.2 Langkah ke-1 Site Definition 

 

2. Klik Next untuk masuk pada kotak dialog berikutnya. Anda ditanya 

apakah akan membuat halaman statis atau membuat halaman dinamis 

dengan bahasa web programming. 

 
Gambar 2.3 Langkah ke-2 Site Definition 

 

3. Klik  untuk melakukan browse dan meletakkan hasil pekerjaan web 

kita. 
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Gambar 2.4 Langkah ke-3 Site Definition 

 

4. Pilih Local/Network dan masukkan alamat folder situs kita 

 
Gambar 2.4 Langkah ke-4 Site Definition 
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Gambar 2.5 Langkah ke-5 Site Definition 

 

5. Klik Done untuk mengakhiri proses. 

 
Gambar 2.6 Langkah ke-6 Site Definition 
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Selanjutnya akan muncul dalam Files Panel root folder lokal, sebagai 

bukti bahwa langkah-langkah diatas telah sukses dilakukan. 

 
Gambar 2.7 Langkah ke-7 Site Definition 

 

2.3 Membuat Halaman Baru 
Untuk membuat halaman web baru, gunakan perintah menu File > New 

atau dengan shorcut Ctrl + N 

 
Gambar 2.8 Membuat Halaman Baru 
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2.4 Melihat Situs Lokal 
Anda dapat melihat file-file yang ada pada situs lokal maupun situs 

remote (pada server), karena site panel memiliki kemampuan untuk 

koneksi ke server dengan menggunakan protokol FTP, LAN, WebDav, RDS 

maupun Source Safe Database. 

 
Gambar 2.9 Tampilan Situs Lokal 

 

Sedangkan prosedur untuk melihat struktur dan file situs adalah : 

1. Pastikan aktif dalam Files Panel 

2. Klik Kotak Site Files View > Site Map 

• Teks dengan warna Merah berarti mempunyai link yang rusak. 

• Teks dengan warna Biru dan dengan ikon Globe sebagai tanda file 

dari site lain atau mempunyai link khusus. 

• Sebuah tanda cek Hijau berarti file tersebut sedang dipilih 

• Sebuah tanda cek Merah mempunyai arti file tersebut sedang 

dipilih orang lain 

• Sebuah ikon yang mempunyai tanda kunci merupakan file yang 

mempunyai sifat Read-Only. 
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Gambar 2.10 Tampilan Situs Lokal secara Site Map 

Toolbar pada Files Panel 

Toolbar merupakan sekumpulan tombol perintah yang terletak dalam 

sebuah bidang garis.  

 
Gambar 2.11 Toolbar Files Panel 

 

Tombol Keterangan 

 Menampilkan nama-nama situs yang telah didefinisikan 

 Menunjukan lokasi atau tempat situs berada 

 Melakukan koneksi atau diskoneksi dari situs remote 

 Refresh secara manual daftar file terhadap lokal atau remote 

 Menyalin file dari situs remote atau testing ke situs lokal 

 Menyalin dari situs lokal ke situs remote 

 Mentransfer copy dari situs remote ke situs lokal 

 Mentransfer copy file lokal ke remote server 

 Mengukur ukuran tampilan site panel 
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3. Mendesain Halaman Web 
 

Mendesain merupakan perpaduan dari seni, iptek dan keterampilan. 

Kriteria Situs yang baik salah satunya adalah mempunyai kesamaan tema 

dalam halaman-halamannya. Sistem Navigasi yang mudah dan dimengerti 

akan membuat pengunjung merasa puas dan akan kembali lagi. 

Font, warna, layout dan image merupakan inti dari kesesuaian sebuah 

desain halaman web. 

 

3.1 Mengatur Properti Halaman 
User Interface pada Dreamweaver MX 2004 sedikit berbeda dengan versi 

MX. Yaitu mengalami peningkatan kemampuan pada toolbar sehingga 

mudah dimodifikasi atau menambahkan fungsi baru. 

Membuka page properties dilakukan dengan cara : 

1. Pilih perintah menu Modify+Page Properties atau Ctrl+J sehingga 

akan muncul gambar 

 
Gambar 3.1 Kotak Dialog Page Properties 

• Appearance 
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Mengatur jenis, style, ukuran dan warna font kemudian warna latar 

belakang dan ukuran margin halaman. 

• Link 

Mengatur jenis, style dan warna font untuk link ketika tampil, rollover 

atau kondisi setelah dikunjungi 

• Headings 

Menentukan sendiri style yang digunakan untuk teks naskah anda 

• Title/Encoding 

Memberikan judul halaman pada bagian title  

• Tracing Image 

Fasilitas untuk membuat latar belakang dari sebuah image dan bisa 

diatur tingkat ketajamannya. 

 

Menambah Judul Halaman Web 

Title digunakan untuk memberikan judul halaman web. Selain kotak 

dialog  Page Properties. 

 

 
Gambar 3.2 Toolbar Document 

 

Membuat Latar Belakang dengan Gambar 

Langkah-langkah untuk mengambil gambar dan menggunakannya sebagai 

latar belakang, adalah : 

1. Klik kanan lembar kerja Document Window, pilih Page Properties. 

2. Pada kotak dialog, klik tombol Browse. 

 

 
Gambar 3.3 Kotak Teks Background Image 
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Mengisi Latar Belakang dengan Warna 

Dengan mengklik dropdown pada bagian Background. 

 
Gambar 3.4 Tampilan pilihan warna untuk background 

 

Menentukan Warna untuk Teks Link 

Selain warna default untuk teks pada halaman web. Ada beberapa jenis 

teks yang lainnya, seperti : 

• Links, Warna yang akan digunakan pada semua teks dan email link 

yang mengandung hyperlink. 

• Visited Links, Warna yang akan digunakan pada link yang sudah 

pernah dikunjungi. 

• Active Links, Warna yang akan digunakan pada link yang sedang 

ditunjuk atau pada saat pointer mouse masih dalam keadaan ditekan 

pada teks link. 

• Rollover Links,  Warna yang akan digunakan pada link saat pointer 

mouse melewati teks tersebut. 

 

Menentukan Ukuran Margin 

Untuk menentukan batas margin pada lembar kerja Dreamweaver. Anda 

dapat memasukkan nilai pada kotak teks margin, yakni : Left Margin, Top 

Margin, Right Margin dan Bottom Margin. 
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Memberikan Gambar untuk Tracing 

Di dalam kotak dialog Page Properties bagiab bawah terdapat properti 

Tracing Image. Tracing Image adalah sebuah gambar bertipe JPEG, GIF 

atau PNG. 

Caranya sebagai berikut : 

• Klik Kanan pada lembar kerja dan pilih menu Page Properties. Klik 

tombol Browse disamping pilihan Tracing Image. 

 

 
Gambar 3.5 Tampilan Slide Transparancy 
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4. Tabel 
 

Dalam Macromedia Dreamweaver MX 2004, tabel yang digunakan ada 2 

jenis. Yaitu tabel biasa dan layout tabel 

 

4.1 Membuat Tabel 
Yang dimaksud Tabel biasa adalah sebuah tabel sederhana yang biasa 

anda buat melalui program Word dan tabel biasa ini merupakan inti dari 

tabel layout yang anda buat. Langkah membuat sebuah tabel biasa, 

sebagai berikut : 

1. Letakkan kursor pada lembar kerja document window. 

2. Gunakan menu Insert+Table (Ctrl+Alt+T) 

 
Gambar 4.1 Kotak Dialog Tabel 
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3. Contoh jika kita masukkan nilai Rows :3 dan Columns :5 dengan 

border :1 

 
Gambar 4.2 Contoh Tabel 

 

4. Tampilkan Properti Tabel dengan cara Window+Properties atau 

Ctrl+F3 

 
Gambar 4.3 Property Inspector Tabel 

 

Keterangan Tabel 

• Table id, Untuk pemberian nama Tabel selanjutnya digunakan dalam 

pemrograman. 

• Rows, Menentukan Jumlah Baris 

• Cols, Menentukan jumlah Kolom 

• CellSpace, Memberikan jarak antar sel dalam Tabel 

 
Gambar 4.4 Tabel dengan nilai Cellspace yang berbeda 
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CellPad, Mengatur jarak antar isi sel dengan batas tepi sel 

 
Gambar 4.5 Tabel dengan nilai Cell Padding yang berbeda 

 

4.2 Mengubah Properti Tabel 
Beberapa istilah dalam perubahan dalam sebuah Tabel, yakni : 

• Merge, Menggabungkan dua atau lebih sel yang bersebelahan 

 
Gambar 4.6 Tampilan beberapa cell setelah digabung 

 

• Splits, Untuk memecah sel menjadi beberapa baris atau kolom 

 
Gambar 4.7 Kotak Dialog Split Cell 
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Gambar 4.8 Tampilan cell setelah dipecah 

 

• No Wrap, Digunakan untuk mencegah agar teks yang dimasukkan tidak 

berlipat atau berpindah baris sehingga akan berada dalam satu baris 

yang sama. 

 
Gambar 4.9 Tampilan Teks menggunakan No Wrap 

 

4.3 Menggunakan Format Tabel 
Format Tabel juga bisa dilakukan dengan memakai model yang telah 

disediakan Dreamweaver, dengan cara : 

1. Pilih Tabel yang akan anda format 

2. Pilih menu Command – Format Table 
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Gambar 4.10 Tampilan Kotak Dialog Format Table 

 

4.4 Contoh Pembuatan Halaman Web 
Lakukan langkah-langkah berikut : 

1. Tambahkan satu buah document window baru 

2. Atur Propertinya 

3. Buat Tabel dengan 19 Baris dan 6 kolom, width 100% dan border 1 

4. Gabungkanlah beberapa Cell 

5. Ubah Border menjadi 0 ubah pula Cellpad dan Cellspace menjadi 0 

6. Gunakan Warna dan imajinasi Anda 
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Gambar 4.11 Tampilan Layout dengan Tabel dan Warna 
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